Notebook software for figuring
with polishing machine
(Excel spreadsheet : Figuring_notebook.xls)

Install :

The installation is done by copying the file to the chosen directory.

Enable macros :

The spreadsheet works with Macros. Depending on the level of protection set in Excel, they
may not work. It is therefore necessary to define a level of protection enabling the use of
these macros.

To do this, click the following commands :

For Excel 2000 and 2003 :

Tools / Macro / Security

Security -\

Security Level | Trusted Publishers

-

) Yery High. Only macros installed in trusted locations will be allowed
ko run. All okher signed and unsigned macros are disabled,

"3 High. ©nly signed macros From trusted sources will be allowed to
run, Unsigned macros are aukomatically disabled,

@'Emedium. You can choose whether or nat ko run pokentially unsafe
Mmacras,

) Low {not recommended), You are not protected From potentially
unsafe macros, se this setting only if wou have wirus scanning
software installed, or wou have checked the safety of all documents
wal open,

Ik ] [ Cancel

Select « Low » to allow enabling macros without a warning message.

If "Medium" is selected, the following message will appear after the opening of the
spreadsheet :



-

Security Warning

"E:hJeesSheniZen XingyOCR Project MC_Excel.xls" contains macros,

Macros may conkain viruses, Ik is usually safe to disable macros, but if the
macros are legitimate, wou might lose some funckionality,

Disable Macros

] [ Enable Macros ] [ Maore Info ]

You will need to click "Enable Macros" to benefit from all the functions of the software.

Click the Microsoft Office Button™ *, then click on « Excel Options » (Excel 2007)

or

File / Options (Excel 2010 and 2013)

Select « Trust Center » then click on « Trust Center Settings ...» and finally on « Macros

Settings » :

r
Trust Center

P

Trusted Publishers
Trusted Locations
Trusted Documents
Add-ins

ActiveX Settings
Macro Settings
Protected View
Message Bar
External Content
File Block Settings

Privacy Cptions

Macro Settings

(7 Disable all macros without notification
@ Disable all macros with natification
(") Disable all macros except digitally signed macros

() Enable all macros [not recommended; potentially dangerous code can run)
Developer Macro Settings

i__! Trust access to the VBA project object model

QK ] | Cancel

= — = 2

Select « Enable all macros » to allow enabling macros without warning message.



If "Disable all macros with notification" is selected, a security warning will appear after
opening the spreadsheet :

Excel 2007 :

The banner below appears below the Ribbon :

@ Security Warning Macros have been disabled. Options...

Click on the "Options" button in the message and check "Enable this content" in the window
below and then OK to enable macros.

Microsoft Office Security Options

@ Security Alert - Macro

Macro

Macros have been disabled, Macros might contain viruses or other security hazards, Do
not enable this content unless you trust the source of this file,

Warning: It is not possible to determine that this content came from a
trustworthy source. You should leave this content disabled unless the
content provides critical functionality and you trust its source.

More information
File Path: H:\ChE2160'\Excel Stuff\QuadraticRioots, xlsm

) Help protect me from unknown content {(recommended)

COpen the Trust Center QK Q [ Cancel

Excel 2010 and 2013 :

The banner below appears below the Ribbon :

*‘ Security Warning  Macros have been disabled. m

Just click "Enable this content" to allow macros.

Install Excel Solver:

The spreadsheet uses the Excel Solver tool for treating complex algorithms.
The Solver add-in is not necessarily installed by default. The procedure to install it is as
follows :



Excel 2000 and 2003 :

Tools / Add-Ins ...

Select « Solver Add-in » if this option is not checked

Insert the original Excel installation CD (or specify the directory of installation files) to install
the Solver Add-in.

L 1
Add-Ins
Add-Ins available:
; Euro Currency Tools -~ 0
L_|Euro Currency Tools B |
| Export For tWeb Cancel

Find/delete links
|_|iButton USE Control
Internet Assistank YBA
Loakup WWizard

Mame Manager Lkiliky
Proper Cell Text Excel Add-In
PTS Dak Plakker

PTS Waterfall Chart Likiliky
CQuick, %Y Charks

Solver Add-in

w¥ Chart Labeler 6,23

Browse. ..

|
X

Aukamation.. .

EE< ==

Salver fdd-in

Tool For optimization and equation salving

ust then verify that the Solver is referenced in Visual Basic for Excel. It is therefore necessary
to first enter the Visual Basic Editor:

Tools / Macro / Visual Basic Editor

And then :

Tools / References : check SOLVER

-

References - Solver & YBA Examples.xls

.
Available References:
| Yisial Basic For Applications . Zancel
| Microsoft Excel 11,0 Object Library o)
v SOLVER: ;
v OLE Automation Browse...
| Microsoft Forms 2,0 Object Library
BoxCharter J
ButtonEditar
ExportForit'eb Priotiky
funcres Help
Microsoft Office 11,0 Object Library ﬂ

Microsoft PowerPoint 11,0 Object Library

Microsoft Wisual Basic For Applications Extensibility 5.7
Microsoft Windows Common Contrals 6,0 (3PE)
MarnrMananer

i 2]

SOLYER

Location:  C:\Program Files\Microsoft Office
200 0FFICED 11 Library SOLYERASOLYER. LA

Language: EnglishfUnited States




The spreadsheet is now ready to operate.

First insert the original Excel installation CD (or specify the directory of installation files) to
install the Solver Add-in.

Click the Microsoft Office Button & , then click on « Excel Options » (Excel 2007)
or
File / Options (Excel 2010 and 2013)

%,
A

Recent Documents

TLo@

1 Carnet_retouche 2007 L=l

2 Correspondances Excel 2003 2007 sl
Open

3 Carnet_retouche li=l

4 400GAP =
Save

5 bhulletin =

[l==d] Erint b
[ T
|%#| Prepare ¥

Send L

e

Publish »

L, K
I
(=]
=

| 1] Excel Options i i}( Exit Excel i

Check « Add-Ins » then, in the « Manage » zone, select « Excel Add-ins» and click on
« Go... ».



Excel Options

Popular

Farmulas

Proofing

Save

Advanced

Customize
F.Aﬁd:lns q

Trust Center

Resaurces

View and manage Microsoft Office add-ins.

Add-ins
Mame Lacation Type
Solver Add-in i OfficerOfficel 2\ Library SOLVER solver.xlam Excel Add-in
Analysis ToolPak analys32.xl Excel Add-in
Analysis ToolPak - VBA atpvbasn.xlam Excel Add-in
Conditional Sum Wizard sumif.xlam Excel Add-in
Custom XML Data CounFiles\Micrasoft Office' Officel 220FFRHD.DLL - Document Inspector
Eura Currency Tools eurotoolxlam Excel Add-in
Financial Symbal (Smart tag lists} Chauns'Microsoft Shared Smart Tag'\MOFLDLL Smart Tag
Headers and Footers SacFiles Microsoft Office’,Officel2V\OFFRHD.DLL  Document Inspector

Hidden Raows and Calumns

Hidden Worksheets

Internet Assistant VBA

Invisible Content

Lookup Wizard

Person Mame (Cutlook e-mail recipients)

" Files Micrasoft Office, Officel 2\OFFRHD.DLL
(Files\Micrasoft Office’ Officel 2\OFFRHD.DLL
Maoicrosoft Office’nOfficel 2\ Librany HTMLXLAM
MaoFiles\Micrasaft Office’ Officel 24OFFRHD.DLL
okup.xlam

ChsansiMicrosoft Shared Smart Tag FRAME.DLL

C
C
G
E
£
a

Document Inspectar
Document Inspectar
Excel Add-in
Document Inspector
Excel Add-in

Smart Tag

Add-in:
Publisher:
Location:

Solver Add-in

ChProgram Files\Microsoft OfficetCfficel 25 Libran SOLVER solver.xlam

Description:  Toaol for aptimization and equatian salving

Manage: | Excel Add-ins

V| So.

Ok ] [ Cancel

In the “Add-Ins” window, check "Solver Add-in", and then click OK.

Add-Ins

add-Ins available:

__:I Lookup wWizard
W t &dd-in

[ ] Analysis ToolPak,

[ | analysis ToolPak - YEA
[ | conditional Sum Wizard
:| Eura Currency Toals

[ ]Internet Assistant YEA

Cancel

Browse, ..

ke

Aukornation. ..

Salver Add-in

Tool For optimization and equation salving

You must then reference the Solver in Visual Basic Editor through the "Developer" tab. If it is

not available in the Ribbon, install it as follows :




Excel 2007 :

{ D
Click the Microsoft Office Button "~ , then click on « Excel Options »
Click on « Popular » then, in the « Top options for working with Excel » section, check
« Show Developer tab in the Ribbon » and OK.

Excel 2010 and 2013 :

File / Options
Click on « Customize Ribbon » then check « Developer » on the right table.

To reference the Solver in Visual Basic Editor :

Click on the "Visual Basic" button in the "Developer" tab
And then :

Tools / References : check SOLVER

Références - VBAProject

Reférences disponibles (o] 4

w| Yisual Basic For Applications ” annuler
w| Microsoft Excel 9.0 Object Library
w| OLE Automation .
w| Microsoft Office 9.0 Object Library Parcourit...

w| Microsaft Farms 2.0 Object Librar
/S |

AcrobatPDFMaker
AdobePDFMakery Priorité
EuroTool

Microsoft Office Euro Converter Object Library ﬂ
145 Helper COM Component 1.0 Type Library

IA5 RADIUS Protocol 1.0 Type Library
Acrobat

arrnhat Arress 2.0 Tvne | ibrary

£ >

]

fide

SOLVER.xls

Chemin d'accés ¢ C3\Program FilesiMicrosoft OFficelOFficeMacrolibl Solveu

Langue : anglais/Eraks-Unis

User guide:

Open the "Figuring_notebook.xls" file with your  version of Excel.
The workbook contains several tabs:

e A “Setup” sheet in which you can enter the parameters of the mirror (diameter,
radius, ...), of the Couder screen and enter the first measures that will serve as a
starting point.

e Aseries of sheets for the different working sessions (maximum 50).

* A “Summary” sheet recapitulating the evolution of the results for all sessions.

Enter cells are green. The others are locked.



« Setup » sheet :

Setup figuring notebook Dafe: 277120012 Hiamma " GAP4T Amiroir = 1 Unifs:  mm
Reurvature: 3995 mm OpticalD: 406 mm Obstruction D : mm Mumberofzomes: 7
Light source:  Fized Wavelendth of light: 550 nm i calculation < Texersau workngdirectory: | G
Results :
Zone 1 Zone 2 Zone 3 Zone 4 Zone § Zone & Zone 7
hx 765 1085 133 1535 171E 183 203
hm 38,25 92,50 12075 143,25 162,50 178,75 195,50
hm® (R U3E6206618 | 2191165576 | Sp48035628 | 5133259166 | 6604356723 | 8079438013 9 55556507
readings 1,225 2975 132 6,02 TA15 5925 10,255
measured shift I 1,75 [ rads I 16 [ 1,395 I 150 [ 1.5
theorical shift | 1,77 | 150 I 1,43 I 147 I 148 I 148 |
correction / theorical shift (%) _| 359% | 5% | 05% | 5% | 02% | 3% |
Calculste Suggest hx
Corrections graphic 12 profile of wavefront C=08153 Focogram
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In the « Setup » sheet enter :

* the date of the first control

* the name of the operator

e the serial number of the mirror

* the unit of measurement (mm or inches)

* the radius of curvature of the mirror

* the optical diameter of the mirror

* the diameter of the possible obstruction. It must be a central area full (uncut) on the
Couder screen.

* the number of zones of the Couder screen. This data is used to automatically format
the input tables and graphs.

* the nature of the light source (fixed or moving)

* the wavelength used for the calculations

* the method of calculation of hm (Nils Olof Carlin or Texereau)

* the working directory where the photos to insert are stored

In the zones table :

e the outer radii of the zones (hx). These values can be suggested once the optical
diameter and number of zones entered by clicking the button "Suggest hx"

* measurements for each zone. If you want to take the average of several
measurements, you can enter a formula whose syntax s
=AVERAGE(valuel ;value2 ;... ;valueN)



Click on "Calculate" to see the results (numerical and graphical).
These are detailed in the description of the sessions sheets below.
A final field is used to enter a text commenting on the results and the proposed strategy for
the next session (overhangs, offset, size tools, durations, ...).

« Sessions » sheets :

The data entered in the "Setup" sheet are automatically offset. However, we can modify the
existing contents of the cell with other values. These new data will be offset into the
following sessions sheets.
In addition to the data entered in the "Setup" sheet, the following data must be entered :

¢ plate speed of the machine (rpm)

* added weight on the machine arm

e room temperature (°C)

* polishing powder used

You should then enter the machine data (adjustments and durations):

Left cranck
Length (mm} Speed (rpm})
20
20
20
20

0 tool
mm
200
200
130
150

Right cranck
Length (mm} Speed (rpm)
200 14
200 19
200 19
200 19

Overhang
mm

0]

B4

69

73

Duration
mn}
15
15
13
15

Comments

Offset (mm)

10
15
20
2

%
0%
32%
6%
49%

i
0%
S0%
3%
5%

E0

The table contains as many rows as there are different settings:

* diameters of the different tools used.
Their values are automatically calculated as a percentage of the optical diameter.

e Time sequence (in minutes) for each type of settings / parameters given.

e For each cranck (left and right): length of eccentricity and speed (rpm).

* the offset value.

e the overhang value. This is automatically calculated as a percentage of the tool
diameter.

e free comments

It is possible to format the table with the number of rows you want. To do this, complete the
"Number of lines" field then "Enter" and click on the "Go" button. The table can have 40
lines maximum and 10 minimum.

The measurements are then entered in the same way for the “setup” sheet.

Then click on the "Calculate" button to view the results :

Results :
Zone 1 Zone 2 Zone 3 Zone 4 Zone 5 Zone 6 Zone T
hx 765 1085 133 1535 1715 185 203
hm 38,25 92580 120,75 143,25 16250 17375 19550
hm* /R 0366206618 2141165576 3648035625 5133259166 5604356723 5,079435713 9,55556597
readings 1,225 2975 442 6,02 7415 8,925 10,255
measured shift 1,75 1,445 , 1,395 151 1,33
theorical shift 177 151 149 147 1,48 1,45
correction /theorical shift (%) 99% 96% 108% 95% 102% 90%
correction / theorical shift (%) 5% -7 20% 0% -10%




In the table, we first calculate the hm and hm? / R (classic test data sheet). For zone#1, the
calculation of hm takes into account a possible obstruction.

The following lines contain the calculations :

¢ the measured shift (the difference between the measurements of the two zones on
either side of the spine)

* the theoretical shift (the difference between the hm?/R of the two zones on either

side of the spine)

e correction observed in relation to theoretical shift (in %)

e evolution of the correction from the previous session (this data is particularly useful
to assess the effect of the session being analyzed)

Calculations are also represented by different graphs :

Corrections graphic
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This chart shows the % of correction
between each pair of zones in relation to the
theoretical values (the numerical values
appear in the table of results)

This graph shows the evolution of
corrections between this and the previous
session. It is easier to assess the location and
extent of the effects of retouching.



172 profile of wavefront
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This graph represents the % profile of the
wavefront (the best reference wave is here
parallel to the x-axis). The PTV value is
indicated at the bottom right of the graph. It
is possible to manually change the C
constant to view another focus. In case of
further click on the "Calculate" button, the C
input value will be replaced by its optimized
value.

This graph shows the values of relative
transverse aberration for each zone. The
calculation is optimized in the circle of least
aberration that is to say, the maximum and
minimum values of the aberration values are
equal and of opposite signs. The absolute
value of the maximum aberration is shown
at the bottom right of the graph.

Although largely neglected by amateurs
since the advent of software tools,
representing Millies-Lacroix, however, still
used by some of them. The envelope curves
represent the limits aberrations
corresponding to the diffraction spot. It is
also possible to manually change the C
constant but it is again optimized by
calculating for each click on the "Calculate"
button.



Other frames (in black) allow you to insert tests photographs (Foucault, Ronchi and phase
contrast). To insert an image, click the 4 icon at the bottom right of the corresponding
frame. A browser window opens by pointing the directory specified in the “Setup” tab. Once
the file is selected, the image will be automatically inserted into the frame. To delete the
picture, click the X icon. The titles over the frames can be changed as needed.

In the last input frame "Session analysis and strategy" you can describe the analysis of the
measured shape after the current session (expected effect confirmed or not, possible causes
of non-achievement of objectives, ...) and the deduction in terms of the proposed strategy
for the next session (machine settings, tool size, durations, ...). The completeness of the
information entered in this cell as a basis for defining future strategies more or less
reproduce the actions that have been effective in similar cases.

Once the session input and analyzed, we can create the following by clicking on the "New
session" button. You can also delete the last session created by clicking "Remove Session".

« Summary sheet » :

Summary of sessions Date:  04/01/2013
Mame : GAP4AT R curvature 3 995 mm Optical D 406 mm Obstruction D 0 mm
o, i
Session Date Duration PTV if’p max £ GEELE
L2771 | 7372 | ZAZ3 | Z574 | Z6HZS | ZTFZ6 | Z8FT7 | 7978 | 2109 2117210 | 212211213212

1 17/06/09 60 mn h 83 10 91% | B8% | 105% | 112% | 108% | 93%
2 17/06/09 60 mn W T8 14 101% | 113% | &1% | 102% | 81% [ 112%

[ Total [ Th O]

This sheet allows you to view historical sessions with, for each, the date, the duration, the
PTV, the relative transverse aberrations and % corrections between each zone. The total
duration (in hours and minutes) also appears.



